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Section 1

Getti ng Sta rted 1. SHRIMTOOLS, what for?

SHRIMPTOOLS is a home-made software package for reduc-
ing and analyzing U-Th-Pb data generated by the SHRIMP I
ion microprobe of the IBERSIMS Laboratory at the University of
Granada. To a large extent it is a new implementation of the
PRAWN data reduction software developed for the SHRIMP |,
complemented with some ISOPLOT-like utilities. We have writ-
ten it using the STATA commercial package which runs in Mac,
Windows, or Linux. Data files and program files are fully inter-
changeable between the three platforms.
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1. SHRIMPTOOLS, what for? SHRIMPTOOLS is free, but STATA is a commercial package

2. Why STATA? (www.stata.com). To download an evaluation license go to:
http://www.stata.com/customer-service/evaluate-stata/
3. Which STATA version and flavor?
SHRIMPTOOLS has been tailored to our requirements. We are
4. Useful additional software happy if other people find it useful, so we have decided to write
5. SHRIMPTOOLS file format and installation this manual. The software is as “it is”. Therefore, we accept nei-
ther responsibility nor liability for erroneous results or any other
6. Future developments and updates problem derived from its use.
7. How to mention SHRIMPTOOLS SHRIMPTOOLS has been extensively checked and improved
8.

since 2010. We think it is reasonably bug-free, but one never
knows. If you find a bug, please, report it to us and we shall fix
it as soon as possible.

Reporting bugs and suggestions
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http://www.ugr.es/~ibersims
http://www.stata.com
http://www.stata.com
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If you believe the program lacks some features you really neeq
please, drop us an e-mail with your suggestions and we shall
see whether we can implement them.

2. Why STATA?

STATA is a powerful statistics, graphics and data analysis pack

age, that is extensively documented and well supported. It is
also a programming environment with its own language. There

is a huge library of user-made routines available on the interne

STATA programs (ADO files) are truly multi-platform and run in
dependently of the operating system settings (language, date
formats, etc.).

3. Which STATA version and flavor?
The current version of SHRIPMTOOLS works well with STATA
13, 12 and 11. STATA comes in different flavors (see

www.stata.com) depending on the dataset size it can work with.

Even the simplest version (STATA for student) can run SHRIM
TOOLS. We run it with STATA/IC.

4. Useful additional software

SHRIMPTOOLS runs inside STATA. No additional files or pack

ages are required. Nevertheless, users will probably find it use
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ful to have (1) a text processor (2) a spreadsheet program.

A text processor is often required to manipulate the .pd files

generated by the SHRIMP, especially if these are partially cor-
rupted or contain incomplete analyses. On the Mac we recom-
mend the free application TextWrangler, but any word proces-
sor would probably be suitable.

A spreadheet program is useful to format the tables made by
SHRIMPTOOLS. We provide templates in Apple NUMBERS
and Microsoft EXCEL for producing publication-ready tables.

5. SHRIMPTOOLS file format and installation
SHRIMPTOOLS consists of several (currently 24) ADO files.
These are text files with the extension .ado, which STATA inter-
prets as compilable code files. The user does not need to con-
sider the number or the name of these ADO files. This task is
automatically undertaken by STATA. The only thing the user
must check carefully is the place where the files are installed,
this must be the personal subdirectory of the ADO directory.
This can be found by typing in the STATA command window:
personal [return].

The procedure for installing SHRIMPTOOLS is as follows:

1. Download the Shrimptools_date.zip archive from this link
(www.ugr.es/~fbea)

2. Unzip the archive and open the resulting folder.

3. Move all files to the corresponding /ado/personal directory.
To find where it is, just type: personal [return] in Stata's com-
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mand window. Do not place the Shrimptools_date folder itself
inside the /ado/personal directory, just the .ado files. Tip: be
sure your user has write and read permissions on
theado folder. Otherwise you will have problems to write
new standard files

4. Download and unzip the folder Auxilary_files. This contains
two table templates, one in Apple Numbers and the other in
Microsoft Excel mentioned before, plus two .pd files for train-
ing: the_nice_file.pd, and the_silly_file.pd. The latter is cor-
rupted so that the users can learn how to deal with such prob-
lems.

6. Future developments and updates

We shall try to keep SHRIMPTOOLS up to date with the devel-
opment of the SHRIMP. We are also developing routines for
multicollector work, namely, Pb and O isotopes. However, given
that Peter Lanc’s POXY software covers this subject well, we
are not in a hurry to develop our own routines.

SHRIMPTOOLS is updated frequently. Updates and new ver-
sions will be posted at the link mentioned before.

7. How to mention SHRIMPTOOLS

Bea, F. Shrimptools, a platform-independent software for U-Th-
Pb SHRIMP data reduction and analysis. Computers and Geo-
sciences (submitted).

8. Reporting bugs and suggestions
Bugs and suggestions can be reported to:

. fbea@ugr.es

« pmontero@ugr.es

- ibersims@ugr.es
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Section 2

1. STATA, to begin with

STATA is a complicated program that requires training to use it
efficiently. We strongly recommend that ISOTOOLS users to
spend some time learning STATA basics using the excellent
documentation provided with the program. Here we outline the
STATA features and commands that are essential to work with
ISOTOOLS. In no way can this replace STATA’s Getting Started
manual

STATA is both menu-driven and command-line driven. When

1. STATA, to begin with you open STATA, the following multi-window screen appears:

STATA data files

anananan

mmmmmmmm

Variable types and empty values

e
g ation, Texas 77845 USA
http://www.stata.com
979-696-4600 stata@stata.com
979-696-4601 (fax)

A few useful STATA commands

S N

The graphics window

results window

un 2013
(as of 23 Jun 2013)
evel: 20 Mar 2013 (what's new)

variables window

are up to date.

mmmmmmm

already done command window

command window

1] 1]

Figure 1.1. Main STATA window




The screen is composed of four windows:
results window: Where all results appear

variables window: Where the names of your variables appear
(note that no variable appears in Fig. 1.1 because no dataset is
open). This window has two columns: name and label. Name is
how STATA refers the variable. Label explains what the variable
is. See Section 4 item 1.7

command window: Where the user enter commands using the
keyboard

already-done command window: Where all commands writ-
ten since STATA was opened are recorded. The user can save
this window and reuse all the commands.

The look of the results window may be different from that
shown in Figure 1.1. It can be changed in the STATA General
Preferences window. Go to the window screen, select results
window, and change Color scheme to classic. We found this
color scheme visually pleasant and the least tiring after a long
STATA session.

The easiest way to place a variable name in the command win-
dow is by clicking on it in the command window.

The easiest way to reuse a command is by clicking on it in the
already done command window.

Data Editor (Edit) - fbea_13_7bis_13042908_process.dta

fr— | [ G 4

B | == e}

Edit Browse Filter Variables Properties Snapshots

id[1] G2027-1.1
id std_age std_conc date time sets scans peaks u_ppm
1 . . 2013-5-03 06:43 1 6 9 305.0
2 (2027-10.1 . . 2013-05-03 09:36 1 6 9 1310.5
3 G2027-11.1 . .  2013-05-03 10:07 1 6 9 715.0
4 (G2027-12.1 . . 2013-05-03 10:22 1 6 9 728.5
5 G2027-13.1 . . 2013-05-03 10:38 1 6 9 346.6
6 G2027-14.1 . . 2013-05-03 10:53 1 6 9 3525.9
7 G2027-15.1 . . 2013-05-03 11:24 1 6 9 669.9
8 G2027-16.1 . .  2013-05-03 11:40 1 6 9 409.6
9 (2027-17.1 . . 2013-05-03 11:56 1 6 9 279.1
10 G2027-17.2 . . 2013-05-03 12:11 1 6 9 472.3
11 G2027-2.1 . . 2013-05-03 06:59 1 6 9 258.6
12 G2027-3.1 . .  2013-05-03 07:30 1 6 9 198.4
13 G2027-4.1 . . 2013-05-03 07:46 1 6 9 199.8
14 G2027-5.1 . . 2013-05-03 08:01 1 6 9 488.2
15 G2027-6.1 . . 2013-05-03 08:17 1 6 9 325.1
16 G2027-7.1 . . 2013-05-03 08:49 1 6 9 1522.2
17 G2027-8.1 . . 2013-05-03 09:05 1 6 9 1241.2
18 G2027-9.1 . . 2013-05-03 09:20 1 6 9 1310.4
19 G2031-1.1 . .  2013-05-03 00:13 1 6 9 1842.9
20 G2031-10.1 . . 2013-A5-43 A3 04 1 A Q 1477.1
Vars: 81 | Obs: 177 Filter: Off

Figure 1.2. STATA editor window

1. The first time you open STATA it is a good idea to type the fol-
lowing command in the command window:

2. set more off, permanently [return]

3. This ensures that output will be uninterruptedly displayed in
the results window.




2. STATA data files
STATA data files have the extension .dat. STATA can only open
one file at time, however the file may be really large. Even the

simplest STATA flavor (see www.stata.com) can handle files
much larger than required by SHRIMPTOOLS.

The file content can be seen and accessed at any time by click-
ing the Data Editor or the Data Browser buttons in top of the
main window toolbar. This opens a new window displaying a
spreadsheet-like editor (Fig. 1.2).

There is an important difference between the Data Editor and
the Data Browser. Whereas in the former we can modify the
data, in second we cannot, just look at them.

The Data Editor and Data Browse can be invoked through the
command window by typing:

edit [return] or browse [return]

The user can specify which variables should be shown in the
editor/browser and in which order they will appear. For example

typing:

edit id u_ppm th_ppm [return] will show the variables id,
u_ppm, and th_ppm in the editor.

3. Variable types and empty values

STATA uses different variable types which, for the sake of sim-
plicity, can be grouped in two categories, numeric variables and
string variables. The Editor represents numeric variables in
black and string variables in red.

If a numeric variable in a given observation is empty, STATA
places a dot (.) in it. It is important to remember that STATA un-
derstand the dot (.) as the largest possible numerical value so
that the boolean condition . > any number is always true. If a
string variable is empty, STATA puts an empty string in it.

4. A few useful STATA commands
A user with no experience with STATA still can run SHRIMP-
TOOLS, but he needs to understand the following commands.

list (can be abbreviated as |, for example | id [return] lists all ids
in the file). If no variables are mentioned, the whole dataset
would be listed. If some variables are written after list, only
those would be listed. For example: list u_ppm (or | u_ppm)
lists only the variable with the concentration of Uranium in ppm.
The output appears in the results window.

generate variable_name (can be abbreviated gen vari-
able_name). Creates a new variable “variable_name”. For ex-
ample, gen sum= a + b, creates the variable sum by adding the
variables a and b


http://www.stata.com
http://www.stata.com

To create a new numeric variable with no values type: gen vari-
able_name=. (note the dot).

To create a new string variable with no values type: gen vari-
able_name="" (note the double quote).

replace variable_name (cannot be abbreviated). Changes the
value of the variable_name. For example, replace sum= sum*3
changes the value of sum by three times its value; replace sum
= other_variable changes the value of sum by that of other-
variable.

Caution: replace string_variable= “pepa” is not the same as replace
string_variable=pepa. In the first case all values of the string_variable
are changed to the string “pepa”. In the second case string_variable is
replace by another string variable called pepa.

Tip: generate and replace accept the conditional if. For example, gener-
ate sum = a + b if es==1, creates the variable sum, storing inita + b
only in those observations for which the variable es is equal to 1. If for a
given observation the condition es==1 is not fulfilled, the variable re-
mains empty for that observation. Note that the boolean condition of
equality is written with double =, that is ==.

drop variable_name drops the variable variable_name
drop in 3 drops the observation n° 3

drop in 3/35 drops the observations n° 3 to n° 35

drop if variable_name==any_value drops all observations for
which variable_name has the value any_value

summarize variable_name1 variable_name2 etc... (can be ab-
breviated sum variable_name1i variable_name2 etc...) displays
(results window) the summary statistics for variable_name1 vari-
able_name?2 etc...

ci variable_name1 variable_name2 etc... displays (results win-
dow) the mean, standard errors, and confidence intervals for
variable_name1 variable_name?2 efc...

Graph (w3)

EEHh B

Open Save Print Copy Rename Graph Editor

Wetherill plot. 208-corrected
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206Pb/238U
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Figure 1.3. STATA tabbed graph window



Summarize and ci also accept the conditional if. For example:
summarize variable_name1 if es==1 calculates the summary
statistics for variable_name1 in those observations that have
the control variable es set equal to 1.

5. The graphics window

STATA can display many graphs simultaneously. This can be
done either in a tabbed single graphic window (Fig. 3) or as mul-
tiple floating windows. This option should be selected in STATA
graph preferences screen, as shown in Figure 1.4.

Working with SHRIMPTOOL we found it advantageous to keep
the windows tabbed.

Graphs can be kept displayed as long as they are not replaced
by new graphs with the same name. If we want to keep a
graph, we must rename it using the command: graph rename
new_name.

Tip: STATA takes a while to make the first graph after opening the pro-
gram. This is due to the way STATA handles code. Subsequent graphs
appear more quickly.

Click here to change the windows scheme

Craph
LY al 4 A L | @ (2
General Graph Do-file Editor Syntax Highlighting Windows Internet Saved Settings
ITEETN Printer | Clipboard/PDF |
Scheme: | s2color N
Font: | Helvetica |

Note: changing the scheme will apply to future graphs and will not be applied to the current
graph, if any. To reset the scheme of the current graph, select "Change scheme/size" from
the Graphics menu.

Windowing

4 Open new graphs in tabs instead of windows
V| Confirm before closing multiple tabs

|| Keep tabbed graph list visible in window

. Cancel | | OK

Fgure 1.4. Stata preferences screen.
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Section 1

Invoking
SHRIMPTOOLS

1. Starting SHRIMPTOOLS
2. Troubleshooting invoking SHRIMPTOOLS

Edit View Data Graphics Statistics mWindow Help

Teoo Data >
ey - Graphics >
- ey Statistics I
Open Save Print T Log View

Review Q. | Results
Command _rc

—

1

-t IS S
Statistics/Data Analysis

Figure 2.1. STATA User menu before activating SHRIMPTOOLS

1. Starting SHRIMPTOOLS

Before activating SHRIMPTOOLS, and only for training pur-
poses, go to the STATA User menu and pull it down. Three op-
tions appear: Data, Graphics, and Statistics (Fig. 2.1).

Then, in the command window type: shrimptools [return]
At this point two things should happen:

1. The user menu changes to incorporate a new item SHRIMP-
TOOLS (Figure 2.2)

2. The results screen displays a message like that shown in
Figure 2.3

Edit View Data Graphics Statistics mWindow Help

Weoo Data >
~ - Graphics >
— = Statistics >
Open Save Print | | Shrimptools >
Review Q | Results
Command _rc pd

L@l L

1 shrimptools

Figure 2.2. STATA user menu after activating SHRIMPTOOLS. Note the
appearance of a fourth item: Shrimptools. Compare with Fig. 2.1.



® OO0 Stata 12.1

a ™ E) (=== ] T
L ‘ S =& : Q-
L i I . 1=
Open Save Print Log Viewer GCraph Do-file Editor Data Editor Data Browser More Break Search Help
Review Q | Results Q | variables N Q
Command _rc Iy LOU Name Label
1 shrimptools
« SHRIMPTOOLS: USEFUL TOOLS FOR REDUCTION OF SHRIMP D.
. written by Fernando Bea, 2011, 2012
. It is advisable to work on duplicate data files instead of the originals
. All statistics and plots are on observations with the variable
. The default method for Pb/U correction is Pb/U vs. UO/U. It may be changed to Pb/U vs.U02/U
. or Pb/U02 vs UO/U
. By default, Pb/Pb is not standardized.
. It may be changed for normalization to nominal Temora 207Pb/206Pb value
. Common lead correction is based on Cumming & Richards (1975) model
. It may be changed to Stacey & Kramers (1975) model
Properties g8 (1r) =
. The effect of U excess (>2500 ppm) is corrected according to Williams & Hergt (2000) e P
. This modifies original 206/238 values. The correction can be cancelled Name
. By default, the original uncorrected 206/238 values are not retrieved. This can be modified Label
Type
. To modify defaults, go to the USER menu and choose CHANGE DEFAULTS Format
. Go to the USER menu to continue Value Label
Notes
Data
Filename
Label
Notes
Variables
Observations
Size
Memory

Command

Il | fUsers/ferbea/Desktop/agcasco0l I

Figure 2.3. Results window displaying SHRIMPTOOLS starting message. Note in the upper left corner the command issued to invoke it.

this screen appears, SHRIMPTOOLS was launched successfully.



2. Troubleshooting invoking SHRIMPTOOLS

If none of the above happens or you get an error message,
there are only two possible reasons:

1. shrimptools [return] was mistyped in the command win-
dow. Note it must be written in lower case and entered with
the return key

2. the ado files are not in the correct location (see Chapter 1).




Section 2

Beginning with
SHRIMPTOOLS

1. Before beginning

2. The SHRIMPTOOLS menu

1. Before beginning

Please, read the starting message displayed when you type
shrimptools [return] ver carefully. It gives some instructions
about how to run the software. The normal workflow for dealing
with geochronological data is:

1. Reduce a SHRIMP .pd data file

2. Work with that file to group the spots, calculate the ages
and plot them in concordia diagrams

3. Study the occurrence of outliers and calculate averages for
each group

4. Transfer the results to a publication-ready table

All these task can be done with SHRIMPTOOLS. You can also
transfer the reduced isotope ratios to ISOPLOT. You can prac-
tice with the file the_nice_file.pd provided with the software.

Reducing a SHRIMP .pd data file creates a STATA file with all
the relevant isotope ratios and element concentrations. Two ver-
sions of this file are automatically saved within the .pd file direc-
tory. One is a STATA .dat (binary) file; it would be used in

STATA . The other is a plain text (.txt) file containing exactly the
same information; it can be used in any other program for exam-
ple ISOPLOT. These files are named after the .pd file. For exam-



ple, the_nice_file.pd after being reduced creates the files
the_nice_file_process.dat and the_nice_file_process.txt.

All age calculations, concordia plots, statistics, etc... are done

once my_file_process.dat is created. SHRIMPTOOLS can also
process isotope data reduced by other programs, but the user

must create a .dat file with the same conventions and variable

naming. This is quite tiresome and time consuming; it is better

to begin from scratch using the .pd file.

tatistics I!m Window Help

Data >
. Graphics -
' Statistics > f

= Shrimptools >

Its ‘

mmon lead correction is bas¢
may be changed to Stacey &

e effect of U excess (>2500
000)

is modifies original 206/23¢
default, the original uncor

be modified

modify defaults, go to the
to the USER menu to contin

e b e fe e et e ofe e ofe e fe e fe e et ek ek ok Rk K

t more off, permanently
more preference recorded)

rsonal

Stata 13.0

s I

Change defaults

Write a new standard file
Create log file template
Pb-Pb calculator

SHRIMP U-Th-Pb data reduction
SHRIMP Pb multicollector data reduction

U-Th-Pb ages, no plot
Pb-Pb ages, no plot

Tera-Wasserburg concordia
Tera-Wasserburg plot with ID
Wetherill concordia

Calculate discordia

Wetherill plot with ID

Pb-Pb isochron

U-Pb age statistics
Detect outliers

U-Pb tables (reduced)
U-Pb tables (full)

Figure 2.4. The SHRIMPTOOLS menu.

2. The SHRIMPTOOLS menu (Fig. 2.4)
Most task done by SHRIMPTOOLS are called from the
User > Shrimptools menu. This is split in five blocks:

Block 1 (handy things you do not often use)
Change defaults
Write a new standard file
Create log file template
Pb-Pb calculator
Block 2 (data reduction)
SHRIMP U-Th-Pb data reduction
SHRIMP Pb multicollector data reduction
Block 3 (age calculations with no plots)
U-Th-Pb ages, no plot
Pb-Pb ages, no plot
Block 4 (plots, discordia, and Pb-Pb isochron)
Tera-Wasserburg concordia
Tera-Wasserburg plot with ID
Wetherill concordia
Calculate discordia
Wetheril plot with ID
Pb-Pb isochron
Block 5 (statistics and tables)
U-Pb age statistics
Detect outliers
U-Pb tables (reduced)
U-Pb tables (full)



The next sections explain, in detail, the meaning of each com-
mand.




Section 3

BIOCk 1 . handy 1. Change defaults

By default SHRIMPTOOLS chooses what we consider to be the
best options for data reduction and age calculation, but many of

|
th I n g S yo u d O n Ot these default options can be changed in User > Shrimptools >

Change defaults. You can modify:

Ofte n u se 1. How 206Pb/238U is calculated: 206Pb/238U vs. 254U0O/238U?,

206P /238 vs. 260U0O-/UO?, or 206Pp/260UO, vs. UO/U?, the
default is 254UQO/238U. If you want to use the others options,
make sure that 260UO> has been measured

1. Change defaults 2. 207Pp/206Pph standard normalization. The default is NO. Op-
tion YES is only advisable when the unknowns are younger

2. Write a new standard file than the standard

. Cr log file templ
3. Create log file template 3. U-excess correction. This corrects 206Pb/238U when the U

4. Pb-Pb calculator concentration is higher than 2500 ppm; it follows the proce-
dure of Williams & Hergt (2000). The default is YES

4. Retrieve original 206Pb/238U. This retains the original value
before the U-excess correction. The default is NO

5. Which Pb isotope model to assume for common lead cor-
rection: Stacey & Kramers (1975) or Cummings & Richard
(1985). The default is Cummings & Richard (1985)




6. The percentage of discordia above of which the ID spots are
shown in either the Tera-Wasserburg plot with IDs or the
Wetherill concordia plot with IDs. The default is 5%

7. Which kind of f206 (fraction of non radiogenic 206PDb) is dis-
played in the reduced tables: f206 based on 204Pb (the de-
fault) or 206 based on 208Pb?. The full tables option gives
both calculations

Changes made are maintained as long as you do not close
STATA or do not invoke SHRIMPTOOLS again. However, the
changes are NOT permanently recorded. To restore the de-
faults run the same routine or just enter shrimptools [return]
again.

2. Write a new standard file
SHRIMPTOOLS has a database of standards. Using this option
you can add new ones, just follow the on-screen instructions.

3. Create log file template

This routine creates a .dat file template suitable for storing the
isotope ratios and ages of each sample during a SHRIMP run.
It is useful for having a quick look at provisional results during
an analytical session, but of o use if you are not running the
SHRIMP. Data transfer from the SHRIMP to an external com-
puter needs some additional routines that are not included in
SHRIMPTOOLS.

4. Pb-Pb calculator

This is a simple calculator for 207Pb/206Pb ages, a legacy of the
old good times when we did lead-evaporation analyses. To exit
the calculator key a 9 as the entry for the 207Pb/206Pb ratio.



Section 4

B I k 2 o d t Data reduction is the primary task for which SHRIMPTOOLS
OC . Adia

was designed. The mathematics involved, including error calcu-
lation, are explained in Chapter 3.

reduction =

Data > Stata 13.0
. Graphics > = =
Statistics > { :

== Shrimptools > Change defaults ‘

Write a new standard file
Create log file template
Pb-Pb calculator

be changed to Stacey & |

SHRIMP U-Th-Pb data reduction

i SHRIMP Pb multicollector data reduction
ect of U excess

U-Th-Pb ages, no plot
difies original 6/23¢ Pb-Pb ages, no plot

difie Tera-Wasserburg concordia
1. SHRIMP U-Th-Pb data reduction T -Wassarbitg Flot Wikl
he USER men; to contin Calculate discordia

Wetherill plot with ID

1.1. Conventions using and naming standards ARty 71~ isochron

U-Pb age statistics
Detect outliers
1.2. Trouble reading .pd files ROUPORR  U-7b tabies (recuced)

U-Pb tables (full)

preference recorded)

1.3. Splitting the file

e b soieglion 1. SHRIMP U-Th-Pb data reduction

1.5. Correcting for drift SHRIMPTOOLS processes SHRIMP .pd files. It does not proc-
ess .op files, because they contain less information. Neither
does it processes .xIm files because, at the moment, we found
1.7. Structure and variable naming in the resulting no advantage in doing so. Nonetheless, this may change in the
: future.
STATA file =

1.6. Saving the fully reduced data

2. SHRIMP Pb multicollector data reduction
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| notas_f
| Paper cristina
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| proyecto_2013
| Reguibat_gneisses_f
| Sanabria_f
| Sanaz_April
| SHRIMP_dating Gredos
J SHRIMPTOOLS manual =

|| Figures

M shrimp_file_1.pd

Shrimptools_manual.iba

Cancel Open

Figure 2.6. The open file dialog. Note that only the .pd file is enabled

The file must have been acquired measuring the following

If you enter YES, an open dialog appears (Fig. 2.6). Otherwise

you get the message:

SHRIMP_DECO program aborted by the user.

The open dialog looks for the .pd file on the desktop, but you
can go to any other directory. Note that only .pd files are en-

abled.

User chose /Users/ferbea/En_progreso/SHRIMPTOOLS manual/shrimp_file_1.pd as the filename

SHRIMP SW v3.12 SHR 2 ACQUISITION PRAWN DATA FILE

analyst fbea, mount 13_7bis,

fbea_13_7bis_13042908.52.
Reading analysed spot 1;
Reading analysed spot 2;
Readiny Analyvsed cspot) 33
Reading analysed spot 4;
Reading analysed spot 5;
Reading analysed spot 6;
Reading analysed spot 7;
Reading analysed spot 8;
Reading analysed spot 9;

pd, 29/04/2013, 8:52 AM

Spot ID = SL13

Spot ID = TEM-7.1
Spot o= REG47-22.1
Spot ID = REG47-23.1
Spot ID = REG47-24.1
Spot ID = TEM-8.1
Spot ID = REG47-25.1
Spot ID = REG47-26.1
Spot ID = REG47-27.1

masses: 196Zr-.0, 204Pb, 204.1packground, 206Pb, 207Pb, 208Pp,
2384, 248ThQ, 254U0O, and (optional) 260UQO>

Figure 2.7. Results window displayed during the file readout.

Once the .pd file is open you will see messages in the result
windows displaying (1) the heading of the .pd file, and (2) the
number and ID of each spot read (Fig. 2.7). After finishing it dis-
plays the total number of spots in the .pd file and a list of the
standards currently in the SHRIMPTOOLS database. Before go-
ing any further, we must discuss some conventions regarding
how to name and use the standards.

To process a .pd file, go to User > Shrimptools > SHRIMP U-
Th-Pb data reduction (Fig. 2.5). Once you call the routine a
self-explanatory red line appears in the results window:

This routine will destroy all data currently in memory. Do you
want me to continue? (y/n).




Reading analysed spot 177; Spot ID = TEM-42.1

. 177 spots analyzed

. Standard selection

. This is the list of available standards and their abbreviations
1. TEMORA tem
2. SL13 sl1
3. 91500 z91

. Choose the isotope ratios standard by typing its abbreviation. tem
. Choose the concentration standard by typing its abbreviation.

Fig 2.8. Asking for the name of standards to be used in data reduc-
tion.

1.1. Conventions using and naming standards
SHRIMPTOOLS accepts any standard, which can be easily
added to its database with the routine called by User > Shrimp-
tools > Write a new standard file. In principle we use two
types of standards, one for age and the other for concentration.
The standard for age is usually analysed every four unknowns
(see Fig. 2.7) whereas the standard for concentration is ana-
lysed just once at the beginning of a session. The isotope ratios
standard (also named as the age standard) can be used as con-
centration standards if you so specify it.

One measurement of the concentration standard is always re-
quired; otherwise the element concentrations will not be calcu-

lated. It there is more that one measurement of the concentra-
tion standard, the software uses the average.

For SHRIMPTOOLS to recognize that a spot belongs to a given
standard you must name it accordingly during the analytical ses-
sion. The software trims the spot IDs to the first three charac-
ters, which must match the standard abbreviation (upper case
or lower case does not matter). For example, the TEMORA stan-
dard should be named as TEM-1, TEM-2, ... TEM-XX. Other for-
mats such as TEMORA-1, TEMORA-2, etc... are acceptable as
well, but T-1, T-2,... or TE-1, TE-2 are not. The standard SL13
must be named SL13, or SL13-1, etc. The best way is using the
standard abbreviations (lower case or upper case) displayed by
the program (Fig. 2.8).

If you have an old file with these standards named in a different
way, your best option is to use a text editor such as TextWran-
gle and edit them using find/replace.

1.2. Troubles reading .pd files

If SHRIMPTOOLS issues an error reading a .pd file, the reason
is almost certainly the bad structure of the file. It normally hap-
pens when the SHRIMP was aborted analysing one spot and
the data for such these incomplete spot were incorporated in
the .pd file.

To fix this problem, you must identify the spot at which the file
reading was aborted. You can do this by just looking at the last



206Pb/238U date

.1289768 2013-04-29
.1156097 2013-04-29
.1270468 2013-04-29
.1300172 2013-04-29
.125127 2013-04-29

.1237751 2013-04-29
.1330292 2013-04-29
.1296668 2013-04-29
.1291519 2013-04-29
.1208684 2013-04-29

Figure 2.9. List of standards.

TEM-42.1 .1229026 2013-05-03 12:27

. How many fragments do you want? (1 is the minimum).

Command

Figure 2.10. SHRIMPTOOLS asks whether you want to split the file.

spot ID displayed in the results window. Once the rogue sample
is identified, open the .pd file with a text processor, find the sam-
ple and delete it from the file. An example is given in the trouble-
shooting chapter at the end of the manual.

1.3. Splitting the file
Once you enter the concentration standard, SHRIMPTOOLS
(1) displays a sequential list of the analysed spots of the iso-

Pb/U vs. UO/U
slope= 1.29 (must be near 2)

log Pb/U

1
1.65 iy NS 1.8 1.85
log UO/U

Figure 2.11. 206Pp/238 vs. 254UU0O/238U plot. This is useful for decid-
ing whether the file should be split and which bad standards should
be deleted. See text.

tope ratios standard, including its measured 206Pb/238U, the date
and the time at which they were measured and the standard
number (Figs. 2.9 and 2.10) (2) displays a 206Pb/238U vs. 254UQ/
238U plot (Fig. 2.11) and (3) asks you whether you want to
split the file. This can be decided easily by looking at the table
and the 206Pb/238 vs. 254J0O/238U plot.

When a file does require splitting? Splitting files is not often
done. It is useful if the SHRIMP instrumental conditions



Pb/U vs. UO/U

slope= .38 (must be near 2)
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Figure 2.12. 206Pp/238 vs. 254UU0O/238U plot showing a file that must
be split because of changing duo. Note de difference between the
theoretical and the fixed regression line. Splitting the file causes
each fragment to be reduced following their individual regression
line.

changed dramatically during a run, for example because of the
duo was changed, or if you have assembled a single .pd file
with data from different sessions. The fragments must be se-
quential. The example shown in Figure 2.11 does nor require
splitting (it however requires standard deletion, see below). By

contrast, the example shown in Figure 2.12 does require split-
ting.

If you do not want to split the file, you must enter 1 when
prompted:

. How many fragments do you want? (1 is the minimum)

If you specify 2 or more fragments, you are prompted to enter
the number of the standards that are at the beginning and end
of each fragment. In the case shown in Fig. 2.12, the first frag-
ment would comprise the analyses between standards 2 and 7,
and the second fragment those between 8 and 31.

Once the fragments are specified, the whole data reduction
process is looped independently on each fragment. At the end,
however, all the data are combined in the same file. In short, it
does not matter how many fragments you specify; for each raw
.pd file you only have one reduced .dat file that contains all your
data.

1.4. Deleting standards and choosing the slope in

the 206Ph/238 correction

After specifying the number of fragments SHRIMPTOOLS asks
you whether you want to use all the standards displayed in the
206Pp/238 vs. 254UJ0O/238U plot, or you want to delete some of
them. For example, in Figure 2.11 it would be a good idea to de-
lete standard n° 6. To do this simply enter the number of the



standard to be eliminated. Every time one standard is deleted
the 206Pp/238 vs. 254UU0O/238U plot is redrawn and you may elimi-
nate another standard if required. The process ends when you

The drift function is either a quadratic or a cubic curve, whichever yields lower residuals
207Pb/206Pb adjusted to a quadratic curve
207Pb/206Pb adjusted to a quadratic curve

Manual elimination of 207/206 and 206/238 outliers
. Shall we eliminate outliers? (y/n).

Figure 2.13. Drift corrections

enter O (zero) as the number of the next standard to be elimi-
nated.

After deleting unwanted standard spots, the software asks you
which slope should be used for the oxide correction. The theo-
retical value is 2, but you can choose the slope of the regres-
sion line. If the standards fit well, this would probably be the
most sensible option.

1.5. Correcting for drift
After choosing the slope, SHRIMPTOOLS corrects for drift in
both 207Pb/206Pph and 206Pb/238U,

The software calculates two types of correction, quadratic or cu-
bic. It then calculates the residuals for each correction type and
automatically chooses the best option (Fig. 2.13) plotting the
standard measurements vs. analysis number (analysis time, in
fact). In the plot generated (Fig. 2. 14) the vertical bars indi-
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Variation of 27Pb/%Pb in standard with time
Standard error (95% C.1.) 1.17 %
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Figure 2.14. Standards vs. time. The vertical bar is the error
of each measurement. The horizontal red line is the average
of each measurement. The blue line is the drift function. The
errors in the heading are the point-to-point error.
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fully reduced data

Variation of 27Pb/%Pb in standard with time
Standard error (95% C.1.) 1.03 %

06
1
———
e
e

“PhPh
055
1
—
—jo—
e e
el
L 3

J

0 10 20
analysis number

Variation of 2¢Pb/%2U in standard with time
Standard error (95% C.1.) 0.91 %

1 1
-
>—

4
—_——
—t—

30

1

L

mph/==|
.06 .0625.065.0675 .07
L
-
L
—
1

analysis number

Figure 2.16. Final screen once data are fully reduced.
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cates the error of each standard, the red horizontal line is the
standards average, the blue line represents the drift function
and the heading gives the point-to-point error.

Once the standard measurements are plotted, the software
prompts you if you want to delete any standard from the drift
correction. If you say YES, a new screen appears with the
same plot but with no error bars, no drift function, and the verti-
cal scale fully expanded to cover the variation range of the stan-
dards (Fig. 2.15; before being fooled by the dispersion, check
the vertical scale range). Once you have finished eliminating
outliers, the software recalculates the drift functions and asks
whether to apply them to the unknowns. The query is:

Drift correction:
Shall we leave it uncorrected (1) correct 206/238 (2) or correct also 207/
206 (3)

Option (1) means that no correction is applied. Option (2) cor-
rects 206Pp/238U. Option (3) corrects 206Pb/238U and 296Pb/207Pb.
There is no point in correcting 296Pb/207Pb and not correcting
206Pp/238|J .

1.6. Saving the fully reduced data

After cleaning up the data file, the standards with error bars and
point-to-point errors are plotted anew (Fig. 2.16). Two files with
the same name but different extension (one .dat and other .txt)
are simultaneously automatically saved to the same directory in

which the .pd file is located. The following message is dis-
played:

The file /Users/ferbea/Desktop/pmontero_13-3cinco_13061712_process.dta
has been created in the same folder as the .pd file

The file /Users/ferbea/Desktop/pmontero_13-3cinco_13061712_process.txt
has been created in the same folder as the .pd file

. Done SHRIMP_DECO.

These two files are named after the .pd file. For example, after
reducing my_file.pd the two files created are
my_file_process.dat and my_file_process.txt. One is a STATA
.dat file would be used in STATA . The plain text (.txt) file con-
tains exactly the same information and can be used in any
other program for example ISOPLOT.

1.7. Structure and variable naming in the resulting

STATA file

The file created by STATA is a rectangular array. The columns
are the variables, that is, the spot names, isotope ratios, ages,
etc. The rows are the observations, that is, one row for each
spot measured.

The names assigned to the variables created by SHRIMP-
TOOLS attempt to be self-explanatory and compliant with
STATA conventions, but they might be rather dense. Therefore,
we assigned labels to these variables which are more similar to



Table 2.1. Variables created during data reduction

variable label description (if necessary)
id Spot identifier The spot identifier as entered in the SHRIMP during analysis
std_age Age standard identifier 1 means the spot is an age standard, empty (.) is not an age standard; 0 is a rejected age standard
std_conc Concentration standard identifier | If contains 1, the spot corresponds to the age standard
date Date of measurement
time Time of measurement
sets Number of sets The software can reduce in the same .pd file measurements with different number of sets
scans Number of scans The software can reduce in the same .pd file measurements with different number of scans
peaks Number of measured masses The mass peaks measured may be 9 or 10, depending on whether the mass 260 (UO3) is measured
u_ppm U_ppm The concentration of U in ppm
th_ppm Th_ppm The concentration of Th in ppm
pb_ppm Pb_ppm The concentration of 206Pb in ppm
pb4_pb6 204Pb/206Pb
err_pb4_pb6 | +s 204Pb/206Pb Error in 204Pb/206Pb, calculated at 95% confidence level
f206 204-based f206% fraction of non-radiogenic 296Pb calculated from 204Pb
pb7_pb6 207Pb/206Pb
err_pb7_pb6 | +s 207Pb/206Pb Error in 207Pb/206Pb, calculated at 95% confidence level
pb8_pb6 208Pb/206Pb
err_pb8_pb6 | +s 208Pb/206Pb Error in 208Pb/206Pph, calculated at 95% confidence level




Table 2.1. Continuation

variable label description (if necessary)
pb6_u8 206Pb/238U
err_pb6_u8 + s 206Pb/238U Error in 206Pb/238U, calculated at 95% confidence level
pb7_u5 207Pb/235U
err_pb7_ub5 + s 207Pb/235U Error in 207Pb/235Pb, calculated from the errors in 207Pb/206Pp and 206Pb/238U
pb8_th 208Pb/232Th
err_pb8_th + s 208Pb/232Th Error in 208Pb/232Th, calculated at 95% confidence level
th_u 232Th/238U
err_th_u + s 232Th/238U Error in 232Th/238U, calculated at 95% confidence level
comment Comments This variable indicates whether the spot was a bad standard or close to a bad standard

pbu_err_in_std

Point-to-point 206/238 error

This is the same for all spots, calculated from the measurements of the standard age

pbpb_err_in_std

Point-to-point 206/207 error

This is the same for all spots, calculated from the measurements of the standard age

es

Control variable for plotting

This is a dummy variable used for grouping samples, controlling which samples plot, etc... You will
learn how to use it in the next sections




real names. Variable names and labels appear in the variable
window. If during the process you see variables named as
~000C, ignore them, they are temporary variables created by
STATA, that are automatically deleted at the end of the process.

Typing describe [return] (or d[return]) in the command window
will display all variable names, types, and labels plus informa-
tion about the file size.

Users must not change variable names, because this would
cause software malfunctions. They, however, can change vari-
able labels at their pleasure. To change the label of the variable
new_variable, simply type in the command window:

label var variable_name “new label” [return]

Table 2.1 shows a comprehensive description of the variables
created during data reduction.Note that the file does not contain
variables with ages. These are created after data reduction.
See next section

2. SHRIMP Pb multicollector data reduc-

tion
These routines are being tested. At the moment, it is better not
to fiddle with them.




Section 5

Block 3: age
calculations with
no plots

1. U-Th-Pb ages, no plot
1.1. Naming conventions
1.2. The f206 plot

2. Pb-Pb ages, no plot

1. U-Th-Pb ages, no plot
This is the first task the user must do after data reduction. It
does not plot concordias, it calculates the following:

1. 204Pb common-lead corrected isotope ratios
2. 207Pb common-lead corrected isotope ratios
3. 208Pph common-lead corrected isotope ratios

4. the ages after uncorrected isotope ratios and their concor-
dance

5. the ages after 204-corrected isotope ratios and their concor-
dance

6. the ages after 207-corrected isotope ratios and their concor-
dance

7. the ages after 208-corrected isotope ratios and their concor-
dance

8. f206 from 204Pb (if not calculated during data reduction)
9. f206 from 208Pb

These results must be saved by the user into the .pd file using
STATA’s File > Save menu. They can be recalculated in a snap
at any moment.



Table 2.2. Variables created during age calculations

variable

label

variable

label

flag_uexcesscor

(no label, see note on next page)

err_pb6_u8_8cor

+s 208 _corrected 206Pb/238U

pb6_u8_7cor

207-corrected 206Pb/238U

pb7_u5_8cor

208-corrected 207Pb/235U

err_pb6_u8_7cor

+s 207-corrected 206Pb/238U

err_pb7_u5_8cor

+s 208-corrected 207Pb/235U

pb8_th_7cor

207-corrected 208Pb/232Th

t_pb7_pb6

207Pb/206Pb age (Ma)

err_pb8_th_7cor

+s 207-corrected 208Pb/232Th

err_t_pb7_pb6

+s 207Pb/206Pb age (Ma)

pb7_pb6_4cor

204-corrected 207Pb/206Pb

err_pb7_pb6_4cor

+s 204-corrected 207Pb/206Pb

pb8_pb6_4cor

204-corrected 208Pb/206Pb

err_pb8_pb6_4cor

+s 204-corrected 208Pb/206Pb

pb6_u8_4cor

204-corrected 206Pb/238U

pb6_u8_4cor

204-corrected 206Pb/238U

err_pb6_u8_4cor

+sS 204-correction 206Pb/238U

t_pb6_u8 206Pb/238U age (Ma)
err_t_pb6_u8 +s 206Pb/238U age (Ma)

t_pb7_u5 207Pb/235U age (Ma)
err_t_pb7_u5 +s 207Pb/235U age (Ma)

t_pb8_th 208Pb/232Th age (Ma)
err_t_pb8_th +s 208Pb/232Th age (Ma)

discor % discordance of uncorrected ages

pb7_u5_4cor

204-corrected 207Pb/235U

t_pb6_u8_7cor

207-corrected 206Pb/238U age (Ma)

err_pb7_u5_4cor

+S 204-corrected 207Pb/235U

err_t_pb6_~7cor

+s 207-corrected 206Pb/238U age (Ma)

pb8_th_4cor

204-corrected 208Pb/232Th

t_pb8_th_7cor

207-corrected 208Pb/232Th age (Ma)

err_pb8_th_4cor

+S 204-corrected 208Pb/232Th

err_t_pb8_th_7cor

+s 207-corrected 208Pb/232Th age (Ma)

pb7_pb6_8cor

208-corrected 207Pb/206Pb

t_pb7_pb6_4cor

204-corrected 207Pb/206Pb age (Ma)

err_pb7_pb6_8cor

+s 208-corrected 207Pb/206Pb

err_t_pb~6_4cor

+s 204-corrected 207Pb/206Pb age (Ma)

pb6_u8_8cor

208-corrected 206Pb/238U

t_pb6_u8_4cor

204-corrected 206/Pb238U age (Ma)
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Table 2.2. Continuation

variable

label

err_t_pb6_u8_4cor

+s 204-corrected 206/Pb238U age (Ma)

t_pb7_u5_4cor

204-corrected 207Pb/238U age (Ma)

err_t_pb~5_4cor

+s 204-corrected 207Pb/238U age (Ma)

t_pb8_th_4cor

204-corrected 208Pb/232Th age (Ma)

err_t_pb8_th_4cor

+s 204-corrected 208Pb/232Th age (Ma)

discor_4cor

% discordance of 204-corrected ages

t_pb7_pb6_8cor

208-corrected 207Pb/206Pb age (Ma)

err_t_pb7_pb6_8cor

+s 208-corrected 207Pb/206Pb age (Ma)

t_pb6_u8_8cor

208-corrected 206Pb/238U age (Ma)

err_t_pb6_u8_8cor

+s 208-corrected 206Pb/238U age (Ma)

t_pb7_u5_8cor

208-corrected 207Pb/235U age (Ma)

err_t_pb7_u5_8cor

+s 208-corrected 207Pb/235U age (Ma)

discor_8cor

% discordance of 208-corrected ages

f206_8

208-based f206Pb (%)

1.1 Naming conventions

The age calculations create new variables, named as shown in
Table 2.2. Note that the variable flag_uexcesscor is used by the
program to control whether the U-excess correction has been
applied, and so avoid to applying it again.
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Figure 2.17.208Pb-based f(206) vs 204Pb-based f(206). This plot is useful for
understanding the consistency of the Th-Pb vs U-Pb isotope systems.

1.2 The f206 plot

The routine U-Th-Pb ages, no plot does not plot concordias,
hence the name. But it does plot the 204-based 206 versus
208-based f206. Red dots represent spots with significant differ-
ences between the two parameters; the numbers are the ordi-
nals in the STATA file. This plot is useful to check the consis-
tency of the Th-Pb vs U-Pb isotope systems.



2. Pb-Pb ages, no plot

This routine only calculates the 207Pb/206Pb ages. It is useful for
multicollector Pb isotopes, but not for normal U-Th-Pb geochron
work.




Section 6

B I oc k 4 . ag e p I Ots In contrast to the routines described in the previous sec-

. tion,which work on ALL observations (spots) in the file, the rou-
tines described in this section ONLY work on those observa-
tions (spots) which have the control variable es setto 1. This is
useful for selecting groups, including or excluding samples, etc.
To change the value assigned to es, you must use the STATA
commands list, and replace. A detailed example is given in
Chapter 3.

1. Tera-Wasserburg concordia Before running any of the following routines, the U-Th-Pb ages
routine (Chapter 2, Section 5.1) must have been executed.

2. Tera-Wasserburg plot with ID
1. Tera-Wasserburg concordia
3. Wetherill concordia
When this menu item is selected, the software displays a list of
4. Calculate discordia the U-Th-Pb ages of the samples with es == 1, and prompts for
: - the limits of the concordia:
5. Wetherill plot with ID
. INPUT OF AGE LIMITS FOR CONCORDIA PLOT
6. Pb-Pb isochron e i
. Upper Limit? .

. Labels to plot are multiple of? .
. Shall | plot points (1), points plus error bars (2), or error ellipses (3)?.

Then, it plots three Tera-Wasserburg concordias, one for

common-lead uncorrected data, another for 204-corrected data
and the last for 208-corrected data. To select the concordia lim-
its look at the table displayed in the results window. If the ages




are outside the limits set by the user, STATA automatically ex-
pands the plot.

2. Tera-Wasserburg plot with ID

This routine simply plots dots in 207Pb/206Pb vs. 238J/206Pb coor-
dinates, with no concordia line. Points corresponding to spots
with less than 5% discordance appear in yellow. Points with dis-
cordance greater than 5% appear in red marked with their ordi-
nal number so that they can be easily identify in STATA editor.

The discordance level at which points are plot in red can be
changed in the User > Change defaults menu.

3. Wetherill concordia

Works in exactly the smame order as the TW concordia. The
only difference is that spots can be plotted either as dots or as
error ellipses, but not as points with error bars.

4. Calculate discordia

This routine calculates the best fit discordia line on a Wetherill
concordia, and displays the upper and lower intercept values
with errors and MSWD. The software prompts the user to spec-
ify for which data the discordia should be calculated: common
lead uncorrected, 204-corrected or 208-corrected data.

There are many ways to calculate discordias, and some of
them produce unreasonable low errors. The approach followed
in SHRIMPTOOLS is a robust regression weighted inversely

proportional to the percent of discordance and the distance to
concordia, with the errors being the intercepts of the 95% confi-
dence interval of the regression line on the concordia line.
When points fit a straight line well, all algorithms yield the same
results. But if the scatter around the discordia line is high, differ-
ent algorithms may produce different results. In this latter case
case, one must cast doubts about whether the results are of
any significance.

5. Wetherill plot with ID

This routine simply plots dots in 206Pp/238U vs. 207UU/235U coordi-
nates, with no concordia line. Points corresponding to spots
with less than 5% discordance appear in yellow. Points with dis-
cordance greater than 5% appear in red marked with their ordi-
nal number so that they can be easily identify in STATA editor.

The discordance level at which points are plot in red and their
IDs shown can be changed in the User > Change defaults
menu.

6. 207Pb/206Ph jsochron
This routine is useful for zircons with elevated common Pb.



Section 7

- i i 1. U-Th-Pb age statistics
B I oc k 5 - Stat I St I CS This routine calculates the mean, standard errors, confidence
and tables

intervals and MSWD of spots with the variable es ==1.

2. Detect outliers

This is a very useful routine for detecting outliers for each calcu-
lated age. It ONLY works on spots with the variable es ==1. The
routine first makes a quantile plot. Then, it applies the letter-
value display algorithm and defines two boundaries for outlier
exclusion called inner fence and outer fence.

1. U-Th-Pb age statistics The inner fence includes all observations comprised between
the 25% quartile minus 1.5 times the 25% to 75% quartile

2. Detect outliers

spread, and the 75% quartile plus 1.5 times the 25% to 75%
3. U-Th-Pb tables (reduced) quartile spread.
4. U-Th-Pb tables (full) The outer fence includes all observations comprised between

the 25% quartile minus 3 times the 25% to 75% quartile spread,
and the 75% quatrtile plus 3 times the 25% to 75% quartile
spread.

Lastly, the software makes three kernel density plots (gaus-
sian), one for samples inside the inner fence, another for sam-
ples inside the outer fence, and the last for all samples.




3. U-Th-Pb tables (reduced)

This routine creates a tabulated text file, that can be imported
into any spreadsheet, containing the Th, U, Pb concentrations,
the common-lead uncorrected and 204-corrected U-Th-Pb iso-
tope ratios, and the common-lead uncorrected and 204-
corrected U-Th-Pb ages; it only includes those spots with es set
to 1.

4. U-Th-Pb tables (full)

These are similar to the reduced tables, but also include 208-
corrected isotope ratios and ages, and prompts whether to in-
clude all spots in the .dat file or just those with the grouping vari-
able es==1. It is probably the best option for tables. The result-
ing .txt file can be imported to Apple NUMBERS or Microsoft EX
CEL templates (downloadable with SHRIMPTOOLS) to produce
publication-ready tables.







Section 1

Data reduction
workflow

1. The data structure of single collector SHRIMP
measurements

2. SHRIMPTOOLS workflow
3. Outlier exclusion and data averaging

4. Standard points selection

1. The data structure of single collector SHRIMP

measurements
SHRIMP U-Th-Pb geochronology is currently performed in sin-
gle collector mode. The resulting data structure is schematically
represented in Figure 3.1.

Every spot analysis consists of one or more sets (one in most
cases).

Every set consists of 4 (minimum) to 8 (maximum) scans. In-
creasing the number of scans increases the counting precision,
but also increases the time per spot. In most cases 6 scans is
precise enough for geochron and 4 scans is precise enough for
provenance studies of detrital zircons.

Every scan consists of 9 or 10 mass-peak measurements:
196ZF20, 204Pb, 204-1background, 206Pb, 207Pb, 208Pb, 238U’
248ThQ, 254UQO, and (optional) 260UQO».

Every mass-peak is measured 10 times during a prefixed inter-
val, frequently between 2 s, for 9%6Zr-O and 254UQ, up to 20 s for
207Pb. The system takes another 10 measurements of the Sec-
ondary Beam (SB) total intensity simultaneously with the 10
readings of the mass-peak measurement.

Every set is reduced individually. If more than one set is meas-
ured, the final result is the grand total of all the sets.



Figure 3.1. Data structure of a single collector geochron
SHRIMP U-Th-Pb spot analysis. To avoid crowding the
diagram, we only depicted the structure of one scan.
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Figure 3.2. Workflow of data re-
duction while reading the .pd
file.
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Figure 3.3. Workflow of data reduc-
tion after reading the .pd file. The
cloud-like globes represent interac-
tive contributions of the user
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2. Workflow

Figures 3.2 and 3.3 show the workflow of data reduction from
opening the .pd file to creating the .pd and .ixt files.

3. Outlier exclusion and data averaging
The software works as follows:

It first read and tokenizes the text line containing the 10 meas-
urements for the first mass. Then, using the letter-display value
algorithm (see STATA documentation) it excludes outliers, if
any, from these 10 measurements and calculates the arithmetic
mean of the non-outlier mass-peak measurements.

Following this, it reads and tokenizes the text line containing the
10 measurements of the secondary beam (SB) acquired simul-
taneously with this particular mass peak. As before, it excludes
outliers and calculates the arithmetic mean of the non-outlier
SB measurements. After that, it divides the average mass-peak
measurements by the average SB measurements, and stores
the result. The process is repeated for each mass peak of the
scan. Once finished, the SB-normalized background (measured
at the mass 204.1) is subtracted from the rest of mass peaks
measured in the same scan.

The process is repeated for all scans. After reading the last
scan of the set, the software retains in memory one averaged
and SB-normalized measurement of each mass per scan. That
is, 6 measurements of each 96Zr-0, 204Pb, 204-1packground,

206Pp 207Pp, 208Pp 238, 248ThQ, 254UO if the set consisted of 6
scans.

Next, to reduce the 6 values of each mass-peak to a single
value, the software regress them against the time at which they
were acquired (Fig. 3.4). Note that the acquisition times are dif-
ferent for each mass-peak.

The regression is done first using the robust regression method
-rreg- implemented in STATA. This method is excellent for ex-
cluding outliers, but cannot be applied to measurements with
many observations having identical values. This is likely to be
the case in the measurements of 294-1background and 204Pb, but
it is highly unlike to occur in any other measurement.

If the robust regression is not possible (as mentioned above,
this only happens for 204Pb and 204-1background measure-
ments), the software performs an ordinary lineal regression, cal-
culates the residuals, eliminates the scan of the highest resid-
ual, and repeats the regression.

The differences between ordinary linear regression and robust
linear regression are shown in Figure 3.4. We have found this
procedure especially useful when the spot contains elevated
204Pp, In this case, the first scan of 204Pb tends to be much
lower than the others, similar to what is illustrated in Figure 3.4.



4. Standard points selection

28000 robus,« Once the scans are averaged and the errors calculated, it is still
’ egfes,g, necessary (1) correct 206Pb/238U as a function of U oxidation, (2)
(0)
. 7 (R,q) correct for instrumental drift during (note that a SHRIMP ses-
@ 'RR estimation sion usually lasts for several days).
2 24000 -
> 'OR estimation During these procedures, the software asks, twice, for deletion
@ ) : 2 i i . Z
2 220004 gimary 1egression (OR) 7] o of the isotope ratio standard spots measured every 4-5 un
) © knowns.
@ S
m o
= 20000 e First time the prompt for deletion occurs before calculating the
% log(296Pb/238U) vs. log(224U0O/238U) regression line. Even if you
18000 ° outlier E accept the recommended slope of 2, still is important to delete
o 00 000 300 100 500 600 points which are clear outliers, because this would affect the po-
Time at which the mass-peak was read (s) sition of the centroid.

Figure 3.4. Graphic illustration of the differences between robust re- The second delete prompt occurs before standard normaliza-
gression and ordinary regression when dealing with outliers. Note how tion, when the software displays 2°7Pb/29¢Pb and 205Pb/238U of
the effects of these are insignificant on the robust regression method. the analysed standard spots. If one of these spots is an obvious

outlier, it is better to delete it.
Once the regression, either robust or ordinary, is performed, the

software calculates the scan average and associated error as
the linear prediction and the standard error of the linear predic-
tion at the mid-time of the measurement (Fig. 3.4). All errors are
calculated at 95% confidence interval.

The last procedure is to calculate the required isotope ratios
and propagate the errors accordingly.




Section 2

Age calculations

1. Calculating ages
2. Grouping spots
3. Finding and deleting outliers

4. Calculating statistics and creating tables

1. Calculating ages

Once the .pd and .txt files are saved, SHRIMPTOOLS has fin-
ished the data reduction. From this point onwards, you can cal-
culate ages, etc... using ISOPLOT on the .txt file, or continue us-
ing SHRIMPTOOLS on the .pd file.

In the latter case, the first thing that must be done is to calcu-
late all common-lead corrected isotope ratios and ages with the
routine User > Shrimptools > U-Th-Pb ages, no plot.

2. Grouping spots
The second thing to be done is grouping the analyses you want
to work with. To understand how this works, proceed as follows:

1. Type (in the command window) shrimptools [return]

2. Go to the menu User > Shrimptools > U-Th-Pb data reduc-
tion

3. Answer yes to the question: This routine will destroy all data
currently in memory. Do you want me to continue? (y/n)

4. Once the open dialog appears, navigate to the directory con-
taining the_nice_file.pd and open it. This will display the
spots IDs as they are being read.



. When the software displays the list of standards input tem
(TEMORA) as isotope ratios standard and sl1 (SL13) as con-
centration standard.

. At the prompt: “How many fragments do you want?” input 1

. At the prompt: “Manual elimination of outliers in U oxide cali-

(1 e )]

bration. Shall we eliminate outliers? (y/n)” input “n

. At the prompt: “Which slope do we use, the calculated (1) or
the theoretical (2)?” input 1

. At the prompt: “Manual elimination of 207/206 and 206/238
outliers. Shall we eliminate outliers? (y/n)” input “n”

10. At the prompt: “Drift correction: Shall we leave it uncor-
rected (1) correct 206/238 (2) or correct also 207/206 (3)?”
input 3

11. Check that the files the_nice_file_process.dat and

the_nice_file_process.ixt have been created in the same di-
rectory. Check also that you are now working on the saved
the_nice_file_process.dat.

12. Go to the menu User > Shrimptools > U-Th-Pb age calcu-
lations, no plot

13. Type (command window) list id es [return]. The windows
result displays a list with all analyzed spots. The variable es

Q

Results

Figure 3.5. Output of list id es

has a value of 1 for all sam-
ples except for the stan-
dards which have es =.

14. Type sort id [return]
and then list id es [return]
(Fig. 3.5). Check how now
all spots are alphabetically
ordered.

15. Type replace es=0 [re-

turn] and then list id es [re-
turn]. Check that all values

of es are set to zero.

16. Type replace es=1 in
1/15 [return] and then type
list id es [return]. Check
that all spots belonging to
Sample KA20, and only
these, have es=1

17. Type generate
es_KA20=es [return]. This
creates a new variable con-
taining the current values of
es. Now type list id es
es_KA20 [return] and



check that the two variables are equal.

18. Type replace es=0 [return] and then type replace es=1 in
16/29 [return]. Check that all spots belonging to Sample 1,
and only these, have es=1.

19. Type generate es_KA23=es [return]. This creates a new
variable containing the current values of es. Now type list id
es es_KA23 [return] and check that the two variables are
equal.

20. Repeat the procedure for all samples in the file, selecting
the ordinal numbers in the list displayed after the command
listid ...

21. Once all groups are made, type replace es=0 [return] and
then type replace es=es_K20 [return].

22. Now try different concordia plots and age statistics using
the Shrimptools menu. Check that only the spots correspond-
ing to the selected sample are considered.

23. Now type replace es=0 [return] and try the same plots and
statistics. They are empty.

24. Type replace es=es_KA20 + es_KAZ23 [return] and try the
same plots and statistics. These will include the spots corre-
sponding to samples 1 and 2.

25. You may want to save your grouping. If so, use the File >
Save menu.

26. If you want to get rid of any grouping variable, for example
es_KAZ20, just type drop es_KA20 [return], etc...

Therefore, combining sort id [return, list id es [return] to check
whether es is enabled, replace es=0 [return] to disable es in

the whole data set, and replace es=1 in x/y [return] to enable
es in the desired samples is a fast and easy way to select the
samples we want to project. If these are not correlative, it is pos-
sible to replace es=1 in different x/y, or change es manually in
the editor. Simply type edit id es [return].

If you find a combination of es values that defines a particular
group you want to work with in the future, you can create as
many new variable es_my_group as desired and save them in
the .pd file as illustrated in the example above.

Once grouping samples is done you have at your fingers the
enormous statistical power of STATA to work with your data.

3. Finding and deleting outliers

a) Identifying discordant spots

Once you have selected all points belonging to a given sample,
it may be that some of them are markedly discordant and you
want to identify them. For this task, go to Users > Shrimptools
> Wetherill plot with ID (or Tera-Wasserburg with ID). In this



plot all samples with discordance greater than 5% appear in red
and the points are identified with their ordinal number. Type edit
id [return] or list id [return] to check the spots to which they cor-
respond. If you want to narrow the discordance percentage at
which points are identified, go to Users > Shrimptools >
Change defaults and proceed accordingly.

If you want to delete permanently one spot, type delete in x,
where x is the ordinal number. If you want to delete perma-
nently several spots, type delete in x/y, where x to y is the
range of ordinal numbers. See the STATA manual and Chapter
1, Section 2.

b) Identifying concordant points with elevated

dispersion from the mean

The procedure described above is meant to identify discordant
points. The procedure described below is intended to identify
concordant points that have ages very that are very different to
the cluster around the mean. For this, go to Users > Shrimp-
tools > Detect outliers. See the description about how this rou-
tine works in Chapter 2, Section 7.

4. Calculating statistics and creating tables

Once you have defined which spots should be used for calculat-
ing the mean ages (that is, all with es set to one, the rest with
es set to any other value), you can calculate all the mean ages,

errors, and MSWDs with Users > Shrimptools > U-Th-Pb sta-
tistics.

Please, note that the errors calculated here reflect just the dis-
persion around the mean value. These must be expanded with
the point-to-point error of the standards which was calculated
during data reduction. The user must do this manually, adding
up the value stored in the variables pbu_err_in_std and
pbpb_err_in_std to the error of the mean for each age.

After this, the most probable action is to create publication-
ready tables for each group. For this task SHRIMPTOOLS pro-
vides two options:

(1) Users > Shrimptools > U-Th-Pb tables (reduced)

(2) Users > Shrimptools > U-Th-Pb tables (full)

The first option creates a text file that is directly readable by any
spreadsheet. It contains al thel isotope ratios and ages, except
those 208-corrected, for the spots with es set to 1.

The second option creates a text file that is directly readable by
any spreadsheet. It contains all the isotope ratios and ages and
the user can choose which spots are included, either all or just

those with es set to 1. Templates to import the .txt files created

with this utility into Apple NUMBERS and Microsoft EXCEL are

also provided.



Section 3

What if?

i SN

. SHRIMPTOOLS cannot be invoked

The version is higher than the STATA version
A .pd file stops reading

After saving the .pd and .txt files the routine U-
Th-Pb ages, no plot gives an error

Trying a concordia plot or age statistics gives an
error

. The error message “the variable variable is

already defined”

You cannot create a new standard file

1. What if SHRIMPTOOLS cannot be invoked?
Download the latest version of the software. Check it is properly
installed in the ADO/PERSONAL directory of your computer
(see Chapter 2, Section 1). Check the spelling typed in the com-
mand window, it must be shrimptools [return].

2. What if the version is higher than the STATA

version?
All SHRIMPTOOLS routines are set to version 11 or 12. If you
try to run these with any STATA version before 11, you will see
the error message

this is version 10.0 of Stata; it cannot run version 11.0 programs
You can purchase the latest version of Stata by visiting
http://www.stata.com.

The version in STATA ado files permits continued use of old
ADOs in newer STATA versions. If you see the above error mes-
sage you can (i) upgrade STATA, (ii) open the offending ADO
file with a text processor and manually change the version num-
ber. It is in the second line of the program as shown below:

program define shrimp_tables_full
version 11
efc...


http://www.stata.com
http://www.stata.com

If you manually change version 11 to version 10, the ADO will
work with STATA v. 10. Save the file with the same format and
extension.

If you want to run the modified ADO file, either quit STATA and
begin anew, or in the command window type:

program drop “ADO name” [return].

3. What if a .pd file stops reading?

This is usually caused by an incomplete spot analysis. It hap-
pens when the SHRIMP was aborted during a measurement
and the data were incorporated in the .pd file.

For example, try to reduce the_silly file.pd provided with the
software. It will display readings until you get:

Reading analysed spot 11; Spot ID = KA29-23.2
in not found.

The red sentence is an error message that occurred reading
the spot labeled SAMPLE4-6.1. Despite this error, you still can
reduce the data file as follows:

1. Open the .pd file with a text processor
2. Find the offending spot. In this case KA29-23.2
3. Delete all lines corresponding to that sample

4. Save the .pd file with the same format and extensionReduce the result-

ing file

4. After saving the .pd and .txt files the routine U-Th-

Pb ages, no plot gives an error?
The cause is that any essential concentration or isotope ratio
was not calculated during data reduction. Open the editor and
check it. The most common situation is that the U, Th and Pb
concentrations were not calculated because the concentration
standard was not measured at the beginning of the session. If
S0, there are two possible corrections:

1. Open the .pd file with a text processor and paste the readings of the
concentration standard from another .pd file

2. Use the age standard also as concentration standard

None of these solutions is optimal. If the CL images of the age
standard grains do not show excessive contrast, the second
would probably be the most reasonable. If, on the other hand,
the standard age grains are heterogeneous and there is a re-
cent .pd file created under the same instrumental conditions,
the first option is probably more advisable.

5. Trying a concordia plot or age statistics gives an

error?
This occurs when the routine U-Th-Pb ages, no plot has not
been executed previously. Run it and try again



6. The error message “the variable variable is

already defined”?
This may occur when a routine has been aborted and the soft-
ware has not cleaned up all temporary variables. If so, check
the names in the variables window. You can delete all unde-
sired variables after es by typing delete var1-var2 [return]. Af-
ter this run the routine U-Th-Pb ages, no plot.

7. An error message saying that you cannot create

or modify an standard file?
This occurs because the ado folder has no write permission for
the current user. Change it.




